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General information 
This document contains all information for the intended use of the system/product 
delivered. This document is intended for persons with basic knowledge of installation 
and operation of software-controlled systems. General knowledge of operational 
safety as well as basic knowledge of using PCs running Microsoft Windows® are 
required. 

 Read this document and possibly associated safety data sheets carefully before 
first start-up and usage of the components. 

 Observe the safety regulations as well as the regulations on operational health 
and safety and protection of the environment. 

 Use the system/product only in a technically perfect condition. 
 Observe all labels and safety signs on the system/product. 
 Never remove the safety signs and replace or clean them if not readable anymore. 
 Persons who install, operate, uninstall, or maintain our systems/products must not 

be under the influence of alcohol, other drugs, or medication that impairs the 
ability to react. 

 Use only approved spare parts and accessories in order to prevent injuries due to 
unsuitable spare parts and accessories. 

 Observe the technical data and ambient conditions specified in this document. 
 

Validity 
This document is part of the system/product and corresponds to the technical state at 
the time of publication. This document has always to be present at the system/product 
and has to be available to the operating personnel without restrictions, in a complete 
and legible form and at all times. If the operator changes, this document has to be 
handed over together with the system/product. The operator has to ensure that all 
safety measures specified in this document are observed. 

The operating personnel must have read and understood this document before 
performing any task. A basic requirement for safe work is observance of all safety 
notes and steps. This document contains important information about the 
system/product that have to be observed when installing, first starting up, or 
maintaining the system/product. Its structure allows trained personnel to perform all 
tasks. 

LPKF Laser & Electronics AG (abbreviated to LPKF in the following) reserves the right 
to make changes in respect to the content of this document. The figures in this 
document serve as basic understanding and can differ from the actual state of the 
system. 
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Structure of warning messages and safety notes 
The safety notes and warning messages in this document identify hazards and risks 
and they are created in accordance with ANSI Z535.6-2011 and the standards series 
ISO 3864. 

The warning messages are structured as follows: 

 Warning sign (only for injuries) 
 Signal word indicating the hazard class 
 Type and source of the hazard 
 Consequences of non-observance 
 Measures to avoid the hazard 

 + SIGNAL WORD 
Type and source of the hazard! 
Consequences of non-observance. 
 Measures to avoid the hazard. 
 Further measure(s) to avoid the hazard. 

 
Warning messages can also be embedded in the format of the surrounding text in 
order to avoid a visual disruption in a sequence. In this case, they are distinguished as 
follows: 

Type and source of the hazard! 
 Measure(s) to avoid the hazard. 

Warning messages are classified in hazard classes represented by the signal word. In 
the following, the warning messages are described in accordance to their hazard 
classes: 

 DANGER 
Type and source of the hazard! 
This warning message indicates a hazard of high risk that causes death or serious 
injury if not avoided. 
 Measure to avoid the hazard. 

 

 WARNING 
Type and source of the hazard! 
This warning message indicates a hazard of medium risk that can cause death or 
serious injury if not avoided. 
 Measure to avoid the hazard. 
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 CAUTION 
Type and source of the hazard! 
This warning message indicates a hazard of low risk that can cause minor or 
moderate injury if not avoided. 
 Measure to avoid the hazard. 

 

NOTICE 
Type and source of the hazard! 
This warning message indicates a hazard that can lead to possible property 
damage. 
 Measure to avoid the hazard. 

 

Text styles 
Various text attributes, notations, and text structures facilitate reading the document. 
The text attributes (highlightings) inside this document are defined as follows: 

Attribute Function 

italic highlights elements of the user interface and of control elements of 
the system 

bold highlights important information and keyboard input 

Courier New highlights file paths 

[  ] highlights elements of buttons on software user interfaces 

highlights keys of the keyboard 

 

Tasks or procedures that are described in steps are compiled to sequences in this 
document. A sequence consists of at least three components: objective, step, and 
result. 

Component Description 

 Indication of an objective. The sequence starts here. 

1. 
2. 
3. 

Indication of a sorted list of steps. The specified order must be 
observed. 

 Indication of an intermediate result that is followed by further steps or 
the result. 

 Indication of the result. The sequence is finished. 

 Indication of a single step. 
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Additional information 
The following symbols are used to indicate additional information: 

 

This note indicates especially useful information. 

  

 

Advanced information 

This advanced information indicates special knowledge. 

  

Registered Trademarks 
Product and brand names are trademarks of LPKF Laser & Electronics AG, registered 
among others at the US Patent and Trademark Office: LPKF® and the company logo, 
# 2,385,062 and # 2,374,780; Solarquipment®, # 3,494,986; ProConduct®, 
# 3,219,251; Allegro®, # 3,514,950. 

Microsoft® and Windows® are brand names or registered trademarks of Microsoft 
Corporation in the USA and/or other countries. All other trademarks belong to the 
respective owner. 
 

Limited liability 
All data, notes and instructions in this document have been prepared with 
consideration to the statutory standards and regulations, the present state of 
technology, as well as our many years of knowledge and experience.  

LPKF accepts no liability for damage due to: 

 non-observance of this document 
 improper use of the system/product 
 employment of personnel that is not sufficiently qualified 
 unauthorized modification 
 technical changes 
 unauthorized manipulation of the safety devices 
 use of spare parts that are not approved by LPKF 

The actual scope of delivery can deviate from the explanations and presentations 
given here, due to custom designs, the utilization of additional order options, or due to 
the most recent technical changes. 

The responsibilities agreed in the delivery contract, the General Terms and Conditions 
as well as the delivery conditions of the manufacturer and the statutory regulations 
valid at the time of the conclusion of the contract are effective. 
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Warranty 
Please note that the warranty is subject to the current regulations in combination with 
the current General Terms and Conditions. 

All information and instructions in this document have been compiled in observance of 
current regulations and the current state of the art. Before working with the 
system/product, this document has to be read carefully. The manufacturer assumes 
no liability for damage and faults due to non-observance of this document. 

LPKF Laser & Electronics AG provides a 12-months warranty if the following 
conditions are met: 

 The warranty starts on delivery. 
 The warranty covers defects in material or manufacture. During the warranty 

period, such defects are remedied without cost by replacement or rework of the 
defective parts. This service is provided by the LPKF Service. 

For further information on wear parts refer to the chapter scope of delivery. 
 

Customer service 
For technical information contact our LPKF Service: 

Address LPKF Laser & Electronics AG 
Service & Support Rapid Prototyping 
Osteriede 7 
30827 Garbsen 
Germany 

Phone + 49 5131 7095-1333 

Fax + 49 5131 7095-90 

Email support.rp@lpkf.com 

Internet www.lpkf.com 

 

In our continuous effort to improve our documentation we are asking you to give us 
your feedback if you notice any discrepancy when working with the system/product, or 
if you have any comments or suggestions for improvement.  

At the moment of packaging, the system/product has been equipped with the latest 
software version and with the software and hardware documentation currently valid. 
By now, new versions of the documentation as well as new software versions might be 
available. 

For all the latest news and updates visit the support area of our homepage: 
http://www.lpkf.com/support. 

 

 

  

mailto:support.rp@lpkf.com
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This document describes two systems that resemble each other. ProtoMat E34 and 
ProtoMat E44 are identically constructed, differing only in a few characteristics. The 
following always describes the system. For comprehensibility and practicability of the 
instruction steps, it does not matter which of the two systems is described. The 
characteristics that serve for differentiation are marked clearly in this document. 
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1 Safety 
 

This chapter provides an overview of all important safety aspects for protecting 
persons as well as for a safe and fault-free operation of the system/product. There are 
further warning messages in the sections of the individual lifecycle stages. 
 

1.1 Intended use 
 

The ProtoMat E34 has been specially designed for producing single-sided circuit 
board prototypes while the ProtoMat E44 has been designed for producing circuit 
board prototypes of up to four layers. Both systems can also be used to create signs 
and housing components. 

The system is approved for the following processing procedures and materials: 

Processing procedures 

 Milling and drilling of single-sided and double-sided base material 
 Milling and drilling of multi-layer material (E44 only) 
 Milling of SMD solder paste stencils 
 Engraving of signs or housing panels 
 Drilling of plane materials 

Materials 

 GFRP and CFRP base material 
 PTFE or ceramic-filled base material 
 Plastics such as: 

 Polyoxymethylene 
 ABS copolymers 
 Necuron ® 

Any other kind of usage is considered as not intended. The manufacturer is not liable 
for any damage resulting from this, the operator alone bears the risk. Part of the 
intended use is also to follow the instructions for safety, operation, and maintenance of 
the system that are described in this user manual. 
 

 

In case of doubt contact the LPKF Service to receive more information on alternative 
materials or processing procedures. 
 
 

 Only control the system with the system software that is included in the scope of 
delivery. 

The system may only be operated with an extraction system that is sufficiently 
dimensioned and has an integrated HEPA filter. 

 Only use qualified and approved extraction systems. 

 

Contact the LPKF sales department or your local sales representative if you plan to 
use another extraction system. 
 
 

Improper use 
 

The system must not be used for processing highly combustible materials like e.g. 
paper or wood, sealed containers, hollow parts, textiles, or food. 

Do not use the system with a different or modified software. 
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1.2 Residual risks 
 

No residual risks have currently been identified, if the intended use as well as all 
safety regulations are observed. Non-observance can cause personal injuries and 
property damage. 
 

1.3 Basic hazards 
 

Always comply with the warning messages listed here and in the individual sections of 
this documentation to reduce the risks of injuries and property damage and to avoid 
dangerous situations. 
 

Mechanical hazards 
 

 WARNING 
Risk of injury by moving components! 
Moving components can cause serious injuries e.g. crushing injuries or cuts. 
 Never grasp moving components when the system is operating. 
 Observe the follow-up time of the spindle. Before doing any work in the 

processing area or on the processing head, ensure that no component is still 
moving. 

 
 
 

 CAUTION 
Tripping hazard by hoses and cables! 
Hoses and cables are routed to the system. If the hoses and cables are laid 
inappropriately they pose a tripping hazard for the operating personnel. 
 Always ensure that the hoses and cables do not pose a tripping hazard. 

 
 
 

Electrical hazards 
 

 DANGER 
Danger to life by electrical shock! 
Touching energized parts causes a direct danger to life by electrical shock. Damage 
to the insulation or damaged individual parts can be dangerous to life. 
 All work on energized components of the system must be performed by a 

qualified electrician. 
 If the insulation is damaged, switch off the power supply immediately and initiate 

the repair. 
 De-energize all energized components of the system or equipment, before 

working with them. Ensure that the system or equipment is de-energized for the 
whole time of the task. 

 Never bridge or deactivate fuses. 
 Always keep moisture away from energized parts because it can cause a short 

circuit. 
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Thermal hazards 
 

 CAUTION 
Burn hazard by hot surfaces! 
During processing, some system components can heat up so much that direct 
contact can cause burns. 
 Always wear your personal protective equipment. 

 
 
 

Hazards by materials or substances 
 

 WARNING 
Health hazard by faulty extraction! 
When processing materials, gases or dusts hazardous to health can be produced.  
 Ensure that the extraction system is switched on and is working properly. 
 Observe the maintenance intervals of the extraction system. 
 Check the connection to the system regularly. 

 
 
1           Verantwortung des Betreibers  
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1.4 Responsibility of the operator 

Operator 
The operator is the person/company who operates the system/product themselves for 
industrial or commercial purposes, or makes it  
available to a third party for use and has the product responsibility for the safety of the 
system operator/user, the personnel in general, and other persons present.  

Operator's obligations 
The system/product is used in the industrial sector. The operator of the 
system/product is thus subject to the statutory obligations for occupational health and 
safety. 

In addition to the safety instructions in this document, the safety, accident prevention, 
and environmental protection regulations must also be observed at the 
system’s/product’s place of operation. 

The following applies in particular: 

 The operator must inform himself about the effective industrial safety regulations 
and determine additional hazards in a risk assessment that result from the special 
working conditions at the system's/product’s place of operation. The operator has 
to implement these in the form of operating procedures for the operation of the 
system/product. 

 During the total operating life of the system/product, the operator has to check and 
ensure that the established operating procedures comply with the current state of 
the rules and standards and adapt them, if necessary. 

 The operator has to define clear-cut responsibilities for installation, operation, 
trouble-shooting, maintenance, and cleaning. 

 The operator has to make sure that all persons who are working with the 
system/product have read and understood this document. Furthermore, the 
personnel has to be trained and informed about the dangers on a regular basis. 

 The operator has to provide the required personal protective equipment and 
instruct the personnel to wear it. 

 The operator has to instruct the personnel to maintain a clean and tidy workplace. 
Eating and drinking at the workplace and especially while operating the 
system/product must not be permitted. 

The operator is also responsible to keep the system/product in good working order. 
Thus, the following applies: 

 The operator has to ensure that the maintenance intervals stated in this document 
are observed. 

 The operator has to check all safety devices for proper function and completeness 
on a regular basis. 
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1.5 Personnel requirements 

 WARNING 
Accident hazard due to insufficiently qualified personnel! 
Insufficiently qualified personnel cannot assess the risks of using the 
system/product and put themselves and others in danger. 
 Allow only qualified personnel to use the system/product. 
 Keep insufficiently qualified personnel out of the working area. 

 
 

The different tasks described in this document require different qualifications of the 
persons who are to perform these tasks. 

If no personnel qualifications are listed in the individual chapters of this document, the 
operating personnel is intended to perform the tasks. 

Only persons who can be expected to perform the tasks reliably are authorized to 
perform the tasks. Persons whose ability to react is impaired e.g. by drugs, alcohol, or 
medicine, are not authorized. 

This document uses the following qualifications for persons for the different tasks. 

Qualified electrician 
A qualified electrician is able to perform work on electrical systems and to detect and 
avoid possible dangers on his/her own based on his/her professional training, know-
how and experience as well as knowledge of the applicable standards and 
regulations. 

The qualified electrician has been trained for the special field where he/she works and 
knows the relevant standards and regulations. 

Maintenance personnel of the operator 
Maintenance personnel are those persons who are designated by the operator to 
perform simple maintenance tasks (e.g. cleaning the system/product, removing parts 
from the system/product). The operator has to ensure that the personnel is suited for 
performing the work. 

The maintenance personnel is able to perform his/her work and to detect and avoid 
possible dangers on his/her own based on his/her professional training, know-how and 
experience as well as knowledge of the applicable standards and regulations. 

The maintenance personnel has been trained for the special field where he/she works 
and knows the relevant standards and regulations. 

Service personnel 
Service personnel are persons who are authorized by the manufacturer LPKF for 
servicing the system/product. These tasks may only be performed by the LPKF 
Service. 

Operating personnel 
Operating personnel trained by the operator is able to perform his/her work and to 
detect and avoid possible dangers on his/her own based on the training performed by 
the operator, his/her professional training, and his/her know-how and experience. 

The operating personnel has been trained by the operator for the special field where 
he/she works and knows the relevant standards and regulations. 
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1.6 Personal protective equipment 
 

Personal protective equipment protects against health or safety risks when working 
with the system. 

The individual sections of this manual each point out the personal protective 
equipment (PPE) that has to be worn during the different tasks of working on the 
system. 
 

Personal protective equipment 
 

Depending on the application and the material to be processed, the operating 
personnel has to wear the required protective equipment, including: 
 

 Safety shoes protection class 1 
 Protective gloves 
 Respirator mask 
 Hearing protection (safety earmuffs or single-use earplugs) 
 

Description of the personal protective equipment 
 

 

 Protective glasses with side shields 
The protective glasses with side shields serve for eye protection in 
case of flying debris and liquid splashes. 

 
 

 

 Respirator mask 
Respirator masks protect against hazards from harmful substances 
in gases, vapors, and particles. 

 
 

  

 Safety shoes 
Safety shoes protect the feet against crushing injuries, falling 
objects and from slipping on slippery surfaces. 

 
 

 

 Protective gloves 
Protective gloves protect the hands against friction, abrasions, 
puncture hazards and deep cuts as well as when touching hot 
surfaces. 
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1.7 Safety signs 
  

This chapter lists the safety signs/pictograms that are applied to the system and 
describes their meaning. 
 

 WARNING 
Risk of injury by nonobservance of safety signs! 
The safety signs on the system instruct you on safe usage of the system. 
Nonobservance of the safety signs can cause severe injuries. 
 Always observe the safety signs. 
 Never remove the safety signs. 
 If a safety sign is no longer legible, clean or replace the safety sign. 

 
 
 

Safety signs at the housing 
 

 

Safety isolation, Class III 
The system is equipped with a 
safety isolation and uses a safety 
isolating transformer according to 
DIN VDE 0570-2-6 or EN 61558-2-
6. As long as the isolation is not 
damaged, the voltage of live 
components that are accessible 
during operation presents no 
danger of electric shock. 

 
 

1.8 Actions in case of an emergency 
 

Preventive measures 
 Always be prepared for fires and accidents! 
 Keep first aid equipment (first aid kit, blankets etc.) and fire-fighting equipment 

functioning properly and close at hand. 
 Instruct the personnel on incident reporting, first-aid equipment, and rescue 

equipment. 
 Keep access routes clear for emergency vehicles. 

Response to fire and accidents 
 Immediately execute an emergency stop. 
 Switch the main switch to 0 (OFF). 
 Disconnect the supply of external components as quickly as possible. 
 Recover persons from the danger zone if safe to do so. 
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1.9 Environmental protection 
 

NOTICE 
Environmental hazard by improper handling of substances! 
Improper handling of environmentally hazardous substances, especially improper 
disposal, can cause considerable damage to the environment. 
 Take appropriate measures immediately if environmentally hazardous 

substances are accidentally discharged into the environment. If you are in 
doubt, inform the appropriate local authorities about the damage and ask for 
appropriate measures that have to be taken. 

 
 
 

The following environmentally hazardous substances are used: 
 

Lubricants 
Lubricants, such as greases and oils, contain toxic substances. They must not be 
released into the environment. They have to be disposed of by a waste management 
company. 
 

Cleaning agents 
Solvent-containing cleaning agents contain toxic substances. They must not be 
released into the environment. They have to be disposed of by a waste management 
company. 
 



 
 

 

ProtoMat E34/E44 
 

Technical data 

V. 1.0 | LPKF Laser & Electronics AG  19/78 

2 Technical data 
 

Operating conditions 

Data Value Unit 

Temperature range (operation) 15 to 25 °C 

Temperature range (storage, transport) 15 to 35 °C 

Max. humidity, non-condensing 60 % 

IP Code ( IEC 60529) of the power supply unit IP20 - 

Service life 10 Years 

Electrical data 

Data Value Unit 

Power supply  100 to 240  V 

50/60  Hz 

Output power of the power supply unit 120 W 

Mechanical data 

Data Value Unit 

Dimensions (width x height x depth) 370 x 300 x 450 mm 

Weight (without packaging) 15 kg 

Weight (with packaging) 20 kg 

Process data 

Data Value Unit 

Rotation speed range E34: up to 30 000 (variable) 
E44: up to 40 000 (variable) 

min-1  

Travel speed 100 (diagonally) mm/s 

Drilling performance 100 strokes  min-1 

Collet 3.175 (1/8") mm 

Processing area with processing table (x/y/z) 229 x 305 x 5  mm 

Resolution (x/y) +/- 0.8 (0.04) µm (mil) 

Repeatability +/- 5 (0.2) µm (mil) 

Accuracy using the reference-hole system +/- 20 (0.8) µm (mil) 

Emissions 

Data Value Unit 

Sound pressure level LpA (EN ISO 3744) < 70 dB (A) 

Sound power level LwA (EN ISO 3744) 71 (without extraction system) dB (A) 

EMC emission class A - 
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3 Structure and function 
 

This chapter describes the technical structure and the functions of the system. 
 

3.1 Brief description 
 

The system consists of three essential functional units: 

 Processing table 
 Processing head with: 

 Milling spindle 
 E44: additionally with camera 

 xyz positioning system 
 

3.2 Scope of delivery 
 

This chapter provides an overview of the system's scope of delivery. For information 
on optional modules, accessories and extras refer to chapter Optional modules, 
accessories, extras on page 25. 
 

 ProtoMat version E34 or E44 
 Power supply unit with: 

 Mains cable 230 V AC 
 Mains cable with US standard plug 115 V AC 

 Drilling underlay plate 
 Data medium Documentation 
 Data medium CircuitPro PM 
 Basic reference ProtoMat E34/E44 
 Accessories bag ProtoMat E series containing: 

 1 x Soft brush 
 2 x Reference-hole strips 100 mm (red) 
 1 x 19-mm-wide adhesive tape (roll of 10 m) 
 2 x Reference-hole drills 1/8" shaft, 17 mm, d = 2.95 mm 
 5 x Dowel pins 3m6x8 (ISO 8734) 
 1 x Mains cable 125 V AC 
 1 x USB cable 
 1 x Press-fit tool (for dowel pins) 
 1 x Extraction hose 
 2 x Set screws with Torx drive and rounded head 
 1 x Torx wrench T20 
 1 x Collet brush 4 mm 
 1 x Flanged bushing Ø12 

Data medium Documentation 
The data medium contains the following: 

 User manual ProtoMat E34/E44 
 Basic reference ProtoMat E34/E44 
 User manual CircuitPro PM 
 How-to guide CircuitPro PM 
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 Product catalog Rapid Prototyping 
 Unpacking instructions 

Data medium CircuitPro PM 
The data medium contains the following: 

 CircuitPro PM software 
 User manual CircuitPro PM 
 How-to guide CircuitPro PM 
 

Accessories kit (order code: 127696) 
The accessories kit contains the following: 
 

Description Quantity 

Drilling underlay plate, 229 mm x 305 mm, d=2 mm (pre-drilled) 10 

Base material FR4, 229 mm x 305 mm, 0/35 μm (pre-drilled) 10 

Base material FR4, 229 mm x 305 mm, 35/35 μm (pre-drilled) 5 

Special adhesive tape 1 

Board cleaning pad 3 

Tool kit - 1/8" shaft with spacer rings 1 

Table 1: Accessories kit E34/E44 
 

Wear parts 
 

The following wear parts are excluded from the warranty: 
 

 Bushing 
 Set screw 
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3.3 Type label 
 

The type label is located at the housing of the system. For information on identifying 
the system and the relevant equipment, specify the system model and the serial 
number on the type label when you contact the LPKF Service. 
 

  

Fig. 1: Type label 
1 Country of origin 
2 System type 
3 Serial number 
4 Year of manufacture 

 5 Operating voltage 
6 Power rating 
7 Line frequency 

 

 
 

1 

2 

3 

4 

5 
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3.4 System components 
  

This chapter describes the components of the system. First of all, make yourself 
familiar with the individual components of the system before starting the operation. 
Before operating the system, also inform yourself about the important software 
elements and the different operation modes. 
 

3.4.1 Total view 
 

 

Fig. 2: System overview 
1 Processing head (E44 with camera) 
2 Screwdriver and insertion tool 
3 On/Off switch 
4 Dowel pin 

 5 Processing table 
6 Type label 
7 Extraction fitting for the extraction system 

 
 

3.4.2 Processing head 
 

The processing head moves on the x and y axis above the processing table and 
processes the PCB with the inserted tool. The ProtoMat E44 additionally has a 
camera for recognizing the fiducials. The tools in the collet are exchanged manually by 
the operating personnel. 

4 
3 

2 

1 

6 

7 

4 

5 
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Fig. 3: Processing head 
1 Milling-depth adjustment 
2 Operation LED 

 3 Collet 
4 Camera (E44 only) 

 
 

3.4.3 Processing table 
 

The material is placed and affixed on the processing table and is subsequently 
processed by the processing head. The processing table has a reference-hole system 
with two dowel pins on an exactly defined line. These enable to produce double-sided 
PCBs precisely, even without a camera. Match-up of the top and bottom layers is 
achieved by the dowel pins. 

 
Fig. 4: Processing table 
 
 

3.4.4 Vision system 
 

The system can recognize the fiducials on the material with the camera and thus 
measure the material exactly. Furthermore, the camera can be used to check the 
milling width result and thus the milling width adjustment. 

1 

2 

4 

3 
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Fig. 5: Vision system 
 
 

3.5 Optional modules, accessories, extras 
 

The system can be equipped with the following accessories: 
 

 Tools 
 Extraction system with automatic On/Off function 
 Measuring microscope with 100x magnification, metric scale, and lighting 
 Precision ring kit (order code: 116698) 
 

 

For more information contact the LPKF sales department or your local representative. 

 
 

Extraction system 
 

LPKF recommends using the JetStream iSeries AX079-25 extraction system. For a 
detailed description of the extraction system refer to the manufacturer's manual 
delivered with the extraction system. 

The extraction system that you use should have the following characteristics: 
 

Characteristics Data 

Extraction air flow at least 186 m3/h 

Extraction fitting Ø 50 mm 

Separation efficiency > 98% (≙ filter class: at least E12) 

Table 2: Extraction system 
 

 Use a HEPA filter of class 12. 
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 CAUTION 
Health hazard by insufficient filtration! 
Filters cannot be cleaned or reused. If you are using saturated, defective or no 
filters at all, filtration of particles that can be harmful to health is not guaranteed. 
 Only operate the system with installed and working filters. 
 Observe the recommended maintenance intervals and replace the filters in 

time. 
 Dispose of the saturated filters properly. Observe the local disposal regulations. 

 
 
 

 WARNING 
Health hazard by gases or dusts! 
Processing materials with laser beams can produce gases or dusts hazardous to 
health. 
 Only process materials that are approved by LPKF. 
 Always ensure that the extraction system is switched on and working properly. 

 
 
 

 

If you are using other accessories, refer to the manufacturer’s manual for more 
information. 

 
 

All consumables and tools can be found in the product catalog. They can be ordered 
individually or in kits. 
 

3.6 Connections 
 

This chapter describes the connections of the system that are located on the rear.  

  

 
 

Fig. 6: Connections 
1 Socket, for connecting the mains cable 
2 USB 2.0 socket, type B, for connecting the 

system to the PC 

 3 25-pin D-sub connector for connecting the 
extraction system 

4 Extraction fitting for connecting to the 
extraction system 

   
 

1 2 3 4 
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Pin assignment 
 

The system is equipped with a 25-pole D-sub socket that provides remote control of 
the external extraction system. This interface is for connecting the control cable for the 
extraction system to transmit control signals and status signals with the system. 
 

NOTICE 
Property damage by a different extraction system! 
Extraction systems that are not approved by LPKF can cause system damage. 
 Use extraction systems that are approved by LPKF in order to guarantee a safe 

use of the system and to avoid damage. 
 Only use the delivered connection cable. 
 If there is any doubt, contact the LPKF Service for checking compatibility of a 

different extraction system. 

 
 
 

Pin Type Name Description 

1, 2, 3, 8 Output   

4 Output Extraction GO = 1 Extraction system control 

5 Output Vacuum GO = 1  

6 Output Status Light GN  

7 Output Status Light YE  

9, 11, 22 GND   

10, 12 Power supply 24 V DC  

13  Status Light RD  

14, 15 Input   

16 Input Vacuum ON = 1 Status of the extraction system 

17 Input INV filter full = 1 Extraction filter full  
(contact closed if filter full) 

18 Input Vacuum GO = 1  

19 Input Cover closed  

20 Input Pressure OK = 0  

21 Input Faststop not 
acknowledged = 1 

 

23, 25 Power supply 24 V DC  

24 GND   

Table 3: Pin assignment D-sub 25-pin 
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3.7 Displays and control elements 
 

This chapter describes the displays and control elements of the system. First of all, 
make yourself familiar with the individual components of the system before starting the 
operation. 
 

 
Fig. 7: Displays and control elements 
1 Milling-depth adjustment 
2 Operation LED 

 3 On/Off switch 
 

 

Figure Description 

 

The milling-depth adjustment can be set with the micrometer screw (1), 
it defines the height of the processing head when milling the toolpaths. 

 

The operation LED (2) displays the operating state of the system. The 
following operating states are displayed at the signal light: 
Lit: The system is ready for operation or in operation. No fault exists. 
Not lit: The system is not ready for operation because it is switched off 
or a fault has occurred. 

 

The On/Off switch (3) switches the power supply on or off. 

Table 4: Displays and control elements 
 

1 

2 

3 
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3.8 Software 
 

The system software CircuitPro PM is used for preparing and converting the PCB 
layout data into a compatible file format (e.g. the LMD format), for further editing the 
data, and for controlling the system. 

The system software imports your CAD data, aperture tables, and tool lists. The 
design rule check checks the conductive track width and the conductive track spacing, 
and lists the inconsistencies in the Message pane. At the same time, these are 
displayed graphically in the CAM view. Thus, you can correct the data before starting 
the actual production process. Additionally, the software serves as automated control 
of the system and enables direct access to all operation parameters. 

 

For a detailed description of the system software refer to the software manual. 

 
 

The user manual and the software are included on the data medium in the delivery. 

 Install the system software on the PC. 
 

After the system software has been installed on your PC, the system has to be 
configured once with the associated equipment. The equipment configuration wizard 
helps you to set up the system. 
 

Equipment configuration wizard 

 
Fig. 8: Equipment configuration wizard  

The Equipment configuration wizard starts automatically at the first start of 
CircuitPro PM. If the wizard does not start automatically, click on Wizards > 
Equipment configuration wizard. 

For further information on the Equipment configuration wizard refer to the 
CircuitPro PM compendium. 
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3.9 Modes of operation 
 

The system has two modes of operation:  

 Production 

 Service  

The production mode is used for normal operation. The service mode is activated by 
entering a password in the software and is reserved for the LPKF Service. 
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4 Transport and storage 
 

This chapter contains important information on transport, packaging and storage of the 
system. 
 

NOTICE 
System damage by improper transport! 
Improper transport can cause damage to the system.  
 Transport the system cautiously to the place of installation.  
 Observe the symbols on the packages.  
 Remove the packaging only directly before system installation. 

 
 
 

4.1 Transport inspection 
 

Check the delivered goods immediately upon receipt for completeness and for 
transport damage.  

If transport damage is evident, proceed as follows: 

 Do not accept the delivery or only with reservations. 
 Record the extent of damage on the transport documentation or on the delivery 

note of the transport company. 
 Initiate a complaint. 
 

4.2 Transport 
 

Prerequisites Tools 
 Safety shoes  Unpacking instructions 

 Protective gloves  
 

 Preparing the system for transport 

1. Switch off the system before transport. 
2. Disconnect all connections of the system (for an overview of the connections refer 

to page 26). 

 

In case of the ProtoMat E44, the camera connections have to be disconnected 
additionally. 

3. Insert a tool or the dummy tool if no tool is in the collet. 
4. Install the transport lock beneath the processing head. 
5. For transport over longer distances, pack the system in its original packaging. 

 

For transport over short distances, the transport lock does not have to be installed 
and the system does not have to be packed. 

 The system has been prepared for transport. 

 

 Follow the unpacking instructions attached to the packaging. 
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 Removing the transport lock 

1. Remove the foam pad beneath the processing head. 
2. Store the foam pad in the box for a possible transport of the system. 

 The transport lock has been removed. 

 

4.3 Storage 
 

 Store the system in its original packaging according to the symbols on the 
packaging. 

 

 Store the packages under the following conditions:  
 Do not store outdoors. 
 Store dry and dust-free. 
 Do not expose to aggressive substances. 
 Protect against sunlight. 
 Storage temperature: 15 °C - 35 °C (59 °F - 95 °F) 
 Relative air humidity: 60 % max, non-condensing. 
 If storing for more than 3 months, check the general condition of all components 

and the packaging on a regular basis. 
 

When putting the system out of operation and into storage over a longer period, 
ensure that the storage room is clean, almost dust-free, and has a sufficient 
loadbearing capacity. 
 

4.4 Packaging 
 

The packaging is chosen according to the transport conditions. 

The packaging is to protect the system from transport damage, corrosion, and other 
kinds of damage until installation. 

 Keep the packaging in its original form. 
 Only remove the packaging just before installation. 
 

4.4.1 Handling packaging material 
 

 Dispose of the packaging material according to the current laws and local 
regulations. 

 

NOTICE 
Environmental hazard by wrong disposal of packaging! 
Wrong disposal of packaging material can cause environmental hazards.  
 Dispose of the packaging material environmentally friendly. 
 Observe the local disposal regulations and hire a specialized company for the 

disposal, if necessary. 

 
 
 

The system may only be shipped in the original packaging of LPKF. Contact the 
LPKF Service if you need the packaging. 
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4.4.2 Symbols on the packaging 
 

Observe the following symbols on the packaging when transporting the system: 
 

 

Top 
The arrowheads of the symbol indicate the top side of the 
package. These always have to point upwards, otherwise, 
the contents could be damaged. 

 
 

 

Keep dry 
Protect packages against moisture and keep them dry. 

 
 

 

Fragile 
Identifies packages with fragile or sensitive contents. 
Handle the package with care, do not drop, and do not 
subject it to shocks. 
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5 First startup 
 

This chapter contains important information on first startup of the system. 
 

5.1 Safety 
 

Observe the following safety instructions for the first startup of the system: 
 

 WARNING 
Accident hazard due to insufficiently qualified personnel! 
Insufficiently qualified personnel cannot assess the risks of using the system and 
put themselves and others in danger. 
 Allow only qualified personnel to use the system. 
 Keep insufficiently qualified personnel out of the working area. 

 
 
 

 CAUTION 
Tripping hazard by hoses and cables! 
Hoses and cables are routed to the system. If the hoses and cables are laid 
inappropriately they pose a tripping hazard for the operating personnel. 
 Always ensure that the hoses and cables do not pose a tripping hazard. 

 
 
 

NOTICE 
Property damage by moisture during transport/storage! 
When transporting or storing the system, moisture can cause damage to the 
system. 
 Ensure that there is no moisture in the system. 
 Before first startup of the system wait approx. 24 hours to allow the system to 

acclimatize. 

 
 
 

5.2 Requirements of the place of installation 
 

Before installing the system, the following requirements of the place of installation 
have to be ensured. 
 

5.2.1 Climatic conditions 
 

The following climate conditions have to be ensured for operating the system: 
 

Climatic conditions 

Temperature range 15 °C to 25 °C 

Humidity max. 60 % non-condensing 

Table 5: Climatic conditions 
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5.2.2 Minimum required space 
 

System dimensions 
 Width  370 mm 
 Depth  450 mm 
 Height 300 mm 

Minimum required space for operation and maintenance 
 Width  1 800 mm 
 Depth  1 100 mm 
 Height 1 820 mm 

The area marked in red in the following figure is the safety zone. It must not be 
blocked by objects. The area marked in blue is the workspace for maintenance and 
must not be blocked. In front of the system, at least 400 mm of space should be 
available for operation and movement. 

 
 
Fig. 9: Minimum required space 
1 PC (recommended position for desk and PC) 
2 System 

 3 Extraction system 

   
 
 

1 

3 

2 
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5.2.3 Workplace of the operating personnel 
 

 
 
Fig. 10: Workplace of the operating personnel 
1 System work station  2 PC work station 
 

 

The system is designed exclusively for operation by a single person. The system is 
operated according to its intended use at the following work stations: 

 System work station 
The system work station is used for loading and unloading the system. 

 PC work station 
The PC work station is used for monitoring the production and for controlling the 
system. 

 

5.2.4 Floor 
 

The floor has to be leveled and antistatic and has to have a sufficient load-bearing 
capacity for the total weight of the system (15 kg). 
 

 WARNING 
Risk of injury by loss of stability! 
Loss of stability due to an improper floor or missing locks can cause uncontrollable 
movement or tipping of the system. This can cause serious injuries. 
 Ensure that the floor has a sufficient load-bearing capacity for the system and is 

even. 

 
 
 

5.2.5 Connections provided by the customer 
 

The following connections must be available for first startup: 

Electrical data 

Data Value Unit 

Power supply  110/230 V 

50/60 Hz 

 
 

1 

2 
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5.3 Preparations 
 

Before the system is installed, you have to consider and ensure the following: 

 A suitable extraction system has to be provided. LPKF recommends using the 
JetStream iSeries AX079-25 extraction system. This is optionally available at 
LPKF. 

 A PC has to be provided by the customer. For detailed information on system 
requirements refer to the user manual of CircuitPro PM. 

 Provide sufficient space at the place of installation. 
 Ensure tidiness and cleanliness at the place of installation. 
 Provide the connection materials (hoses, tubes, cables etc.). 
 The room has to be clean and almost dust-free. 
 

5.4 Connecting the system 
 

Once all preparations are concluded, the system is connected in the following order: 

 Connecting the system with the extraction system 
 Connecting the system with the PC via USB 
 Connecting the camera to the USB port of the system (only E44) 
 Connecting the system to the mains power supply 
 Removing the dummy tool from the collet 

 
Fig. 11: Connecting the system 
 
 

NOTICE 
Property damage by improper startup of the extraction system! 
Improper installation and startup can cause damage to the extraction system. 
 Observe the minimum clearance around the extraction system defined by the 

manufacturer. 
 Use only sockets with protective earth conductor for connecting. 
 Do not use extension cables. 
 Do not bend the extraction hose. 
 Do not block the air flow. 
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 Connecting the system with the extraction system 

1. Check whether all required filters are installed. Install the filters if necessary.  

 

For further information on filter maintenance refer to the manufacturer's manual. 

2. Connect the hose of the extraction system to the extraction fitting of the system. 

 
Fig. 12: Connecting the extraction system 

3. Connect the hose to the air intake on the top of the extraction system. 
 The extraction hose has been connected. 
4. Plug the mains cable of the extraction system into a wall socket. 
 The extraction system is connected to the mains power supply. 
5. Plug the D-sub cable into the LPKF port. 

 
Fig. 13: D-sub connector of the ProtoMat E34/E44 

6. Plug the other end of the D-sub cable into the corresponding connector on the 
front of the extraction system. 

 
Fig. 14: D-sub connector of the extraction system 

 The system is connected to the extraction system. 

 

 

Using a USB hub and/or extension cables can cause transmission problems. Connect 
the system directly with the PC. 
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 Connecting the system to the PC via a USB cable 

1. Plug the USB cable that is included in the delivery into the USB socket of the 
system. 

 
Fig. 15: USB socket 

2. Connect the system's USB cable with a free USB port of your PC. 

 The system has been connected to the PC via a USB cable. 

 

 Connecting the system to the mains power supply 

1. Plug the connector cable of the power supply unit into the power supply socket of 
the system. 

 
Fig. 16: Power supply socket 

2. Plug the mains cable of the power supply unit into a wall socket. 

 The system has been connected to the mains power supply. 

 



 

 

First startup 
 

ProtoMat E34/E44 

40/78  LPKF Laser & Electronics AG | V. 1.0 

 Removing the dummy tool from the collet 

1. Ensure that the system is switched off. 
2. Pull the processing head by hand as far as possible to the front. 

 
Fig. 17: Pulling the processing head to the front 

3. Plug the insertion tool (2) onto the dummy tool in the collet (1). 

 
Fig. 18: Plugging the insertion tool onto the dummy tool 
1 Collet 
2 Insertion tool 

 3 Locking screw 

4. Use the screwdriver in the delivery to loosen the locking screw (3) of the collet (1). 

1 

3 

2 
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Fig. 19: Loosening the locking screw 

5. Pull the insertion tool (2) with the dummy tool downwards out of the collet. 

 
Fig. 20: Extracting the dummy tool 

6. Remove the dummy tool from the insertion tool. 

 
Fig. 21: Dummy tool 

 The dummy tool has been removed from the collet. 
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6 Operating the system 
 

This chapter contains important information on operating the system and the 
associated software programs. 
 

 

For detailed information on operating the software refer to the corresponding user 
manual. 
 

6.1 Safety 
 

 DANGER 
Danger to life by electrical shock! 
Touching energized parts causes a direct danger to life by electrical shock. Damage 
to the insulation or damaged individual parts can be dangerous to life. 
 All work on energized components of the system must be performed by a 

qualified electrician. 
 If the insulation is damaged, switch off the power supply immediately and initiate 

the repair. 
 De-energize all energized components of the system or equipment, before 

working with them. Ensure that the system or equipment is de-energized for the 
whole time of the task. 

 Never bridge or deactivate fuses. 
 Always keep moisture away from energized parts because it can cause a short 

circuit. 

 
 
 

 WARNING 
Health hazard by faulty extraction! 
When processing materials, gases or dusts hazardous to health can be produced.  
 Ensure that the extraction system is switched on and is working properly. 
 Observe the maintenance intervals of the extraction system. 
 Check the connection to the system regularly. 

 
 
 

 WARNING 
Risk of injury by moving components! 
Moving components can cause serious injuries e.g. crushing injuries or cuts. 
 Never grasp moving components when the system is operating. 
 Observe the follow-up time of the spindle. Before doing any work in the 

processing area or on the processing head, ensure that no component is still 
moving. 
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NOTICE 
Property damage by items in the processing area! 
When the system is switched on items in the processing area can cause property 
damage. 
 Before switching on the system, always ensure that no items and no parts are in 

the processing area. 

 
 
 

6.2 Preparations for use 
 

Before working with the system check the following settings and conditions: 
 

 The requirements of the place of installation (see page 34) have to be met. 

 

If a cold system is brought into a warm surrounding, this can lead to condensation of 
humidity. Thus, the system that has been disconnected from the power supply should 
acclimatize for 24 hours before you connect it to the power supply again. 
 Perform a visual check. 
 The following components have to be connected to the system and have to be 

ready for operation: 
 PC (provided by customer) 
 Extraction system 
 Power supply 

 

Operate the system on an over-current protection (230 V / 16 A / 110 V). 

 

6.3 Typical production process 
 

This chapter describes a typical production process. The following steps are 
performed: 
 

 Switching on the system 
 Preparing the data 
 Processing the material 
 Switching off the system 
 

6.3.1 Switching on the system 
 

The system is switched on as follows: 
 

 Switching on the system and the components 
 Starting CircuitPro PM 
 Connecting the PC to the system manually (if necessary) 
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 Switching on the system and the components 

1. Start the PC. 
2. Start the extraction system. 
3. Switch the On/Off switch of the system to position I. 

 The system and the components have been switched on. 

 

 Starting CircuitPro PM 

1. Click on the desktop link or on Start > (All) Programs > LPKF Laser & Electronics 
> CircuitPro PM. 

 The following dialog is displayed: 

 
Fig. 22: Dialog New document 

2. Select a compatible template in the tab Templates or an existing project in the tab 
Projects. 



 
 

 

ProtoMat E34/E44 
 

Operating the system 

V. 1.0 | LPKF Laser & Electronics AG  45/78 

 The dialog is closed and the user interface changes as follows: 

 
Fig. 23: User interface CircuitPro PM 
 

 CircuitPro PM has been started. 

 

 

The connection between the PC and the system is established automatically when the 
system software is started. If the system is not recognized, connect the system 
manually to the PC. 
 
 

 Connecting the PC to the system manually (if necessary) 

1. Click on Machining > Connect... 
 The following message is displayed: 

 
Fig. 24: Selecting the machine type 

2. Click on the drop-down list Machine type and select the connected system (E34 or 
E44). 

3. Click on [Connect]. 



 

 

Operating the system 
 

ProtoMat E34/E44 

46/78  LPKF Laser & Electronics AG | V. 1.0 

 The connection to the system is established. The individual connection steps are 
displayed in the following message: 

 
Fig. 25: Connection steps 

 Once the system has been recognized and its data have been transmitted, the 
user interface of CircuitPro PM is displayed. 

 The PC has been connected to the system. 

 

6.3.2 Preparing the data 
 

This chapter describes how to import the layout data and how to prepare them for 
production. This is done by executing the following steps: 
 

 Importing the data 
 Creating fiducials 
 Generating toolpaths 
 Creating rubout areas 
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 Importing the data 

1. Click on File > Import. 
 The following dialog is displayed: 

 
Fig. 26: Importing the data 

2. Navigate to the following folder: 
Win XP: C:\Programs\LPKF Laser & Electronics\LPKF CircuitPro 
PM 2.3\Example Data\UseCase_DoubleSidedPCB 

Win 7: C:\Program Files (x86)\LPKF Laser & Electronics\LPKF 
CircuitPro PM 2.3\Example Data\UseCase_DoubleSidedPCB 

Win 8 (also 8.1): C:\Program Files (x86)\LPKF Laser & 
Electronics\LPKF CircuitPro PM 2.3\Example 

Data\UseCase_DoubleSidedPCB 

3. Select the files Tutor.TOP and Tutor.BOA. 
4. Click on [Open]. 
 The CAM view changes as follows: 

 
Fig. 27: CAM view with opened project 

 The data have been imported. 
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 Creating fiducials 

Fiducials are created in the Fiducial layer and are drilled into the material during the 
phase DrillFiducial. They have a defined diameter of 1.5 mm. All drilled holes are 
recognized by the system's camera. 

 

It is recommended to create four fiducials. If you use only two fiducials, arrange them 
diagonally. 

1. Click on Insert > Fiducials > Fiducial. 
2. The following dialog is displayed: 

 
Fig. 28: Create fiducial 

3. Click on the positions in the CAM view where you want to place the fiducials. 
or: 
Create the fiducials by entering the x and y position in the dialog. 

 The view changes as follows: 

 
Fig. 29: Four fiducials 

4. Click on [Close]. 

 The fiducials have been created. 
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 Generating toolpaths 

Before a circuit board can be produced, toolpaths have to be generated from the 
imported data. 

The system software helps you creating toolpaths with the Technology dialog. 

1. Click on Toolpath > Technology dialog.... 
 The following dialog is displayed: 

 
Fig. 30: Technology Dialog 
 

You can change the settings of the toolpath generation in the technology dialog by 
clicking on Show details. You can define which tools are available so that only these 
are taken into account for toolpath generation. 

 

For detailed information on general operation and the individual features of the 
Technology dialog refer to the user manual of CircuitPro PM. 

2. Click on the right arrow button in the group Insulate until the Insulation Method 
Partial rubout is displayed. 

3. Deactivate the function Pockets by clicking on the corresponding check mark. 
4. Click on [Start]. 
 The computation results and the tools required for the project are displayed. 
5. Check whether all tools are available. 
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Fig. 31: Computation results 

 

The warning message indicates that source data are missing for some 
computation functions. This is not an error but a notice for the user. 

 

  

 

Advanced information 

The computation results of CircuitPro PM recommend which tools should be used for 
processing the generated toolpaths. If a tool is not available, you can assign another 
tool to the generated toolpath afterwards in the pane Toolpath.  
Please note that using tools with different diameters can cause results that differ from 
the computed data. 
You can also deactivate tools that are not available in the Technology dialog using 
Show details so that these are not used for toolpath generation. 

  
6. Click on [Close]. 
 The dialog with the computation results is closed. 

 The toolpaths have been generated. 

 

Rubout areas enable to produce an especially precise insulation in defined areas. The 
residual copper is partially or completely removed depending on the insulation 
method.  

A rubout area is created on the Top layer of the current layout around the pads of the 
IC. 
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 Creating rubout areas 

1. Click on Insert > Rubout area > RuboutTop. 
 The following dialog is displayed: 

 
Fig. 32: Create rectangle to create a rubout area 

2. Draw a rectangle around the IC's pads of the layout or enter the coordinates of the 
corners in Start point and End point: 

 
Fig. 33: Rectangle surrounding the IC pads 

 

It can be helpful to hide other layers to draw the rubout area depending on which layer 
the rubout area is to be created. 

The presentation of the objects on the individual layers can be defined in the pane 
Layers. 
3. Click on [Close]. 

 The rubout area has been created. 
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6.3.3 Processing the material 
 

This chapter describes how the material is processed based on the prepared data. 
This is done by executing the following steps: 
 

 Placing and fastening the material on the processing table 
 Starting processing 
 Defining the material settings 
 Placing the layout 
 Drilling fiducials (E44 only) 
 Processing the material (Bottom side) 
 Turning the material over 
 Searching fiducials (E44 only) 
 Processing the material (Top side) 
 

 WARNING 
Health hazard by gases or dusts! 
Processing materials with laser beams can produce gases or dusts hazardous to 
health. 
 Only process materials that are approved by LPKF. 
 Always ensure that the extraction system is switched on and working properly. 

 
 
 

 CAUTION 
Burn hazard by hot surfaces! 
During processing, some system components can heat up so much that direct 
contact can cause burns. 
 Always wear your personal protective equipment. 

 
 
 

 CAUTION 
Risk of injury by sharp edges and points! 
Improper handling of the tools used can cause cuts and puncture wounds. 
 Always use the delivered insertion tool. 
 Always store the tools in the tool box. 
 Never touch the processing head during operation. 
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 Placing and fastening the material on the processing table 

Before any processing procedure is started, a drilling underlay plate and the material 
have to be placed and fastened onto the processing table. 

NOTICE 
Property damage by incorrect material thickness! 
The system could be damaged if the entered material thickness does not match the 
actual material thickness. 
 Only one drilling underlay plate at a time may be placed on the processing 

table. 
 Make sure that the entered material thickness is the actual material thickness. 

Measure the actual thickness with a caliper gauge if necessary. 
 

1. Ensure that the processing table is clean. 

 
Fig. 34: Processing table 

2. Place the drilling underlay plate on the processing table in such a way that the 
dowel pins fit into the register holes. 

 
Fig. 35: Processing table with drilling underlay plate 

3. Place the material to be processed on the drilling underlay plate in such a way that 
the dowel pins fit into the register holes. 

NOTICE 
Damage by wrongly inserted dowel pins! 
The processing head can damage the dowel pins in case of contact. 
 Ensure that the dowel pins do not protrude from the material to be processed. 

 

4. Fasten the material to be processed along its edges with the adhesive tape 
included in the delivery. 



 

 

Operating the system 
 

ProtoMat E34/E44 

54/78  LPKF Laser & Electronics AG | V. 1.0 

 
Fig. 36: Fastening the material 

 

The adhesive tape must be fully removable. Use the provided adhesive tape or an 
equivalent adhesive tape.  

 The material is fastened onto the processing table. 

 

 Starting processing 

 
Fig. 37: Operate 

1. Click on Machining > Process all. 
Ensure that the value Process all is selected in the group Operate so that all phases 
are processed. 

2. Click on . 
 The phase MountMaterial is started. 

 The processing is started. 

 

Instead of processing all phases automatically, individual phases can be processed as 
well. To do this, select the phase that you want to start with and click on . 
 

 

Process planning wizard 

CircuitPro PM facilitates setting the parameters via the Process planning wizard. 
For detailed information on using the Process planning wizard refer to the CircuitPro 
PM compendium. 

  
 

Once you have started processing, the system processes the job in different phases. 
These phases are displayed as messages. 

Depending on the system used, the displayed messages and phases can differ from 
the following. Follow the instructions on your screen. From time to time, you are 
prompted to exchange the tool in the collet. 
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 Defining the material settings 

1. Mount the material onto the processing table if not already done. For more 
information on mounting and fastening the material refer to page 53. 

2. Click on [OK]. 
 The phase MaterialSettings is started. 

 
Fig. 38: Material settings 

3. Enter the correct values for the material used in the dialog Material settings. 
In the group Application, the material PCB is selected as default. 

4. Edit the values for the copper layer thickness and material thickness if necessary. 
5. For defining the material area, move the dialog Material settings to the side. 
6. In the Machining view click on the position of the screen that represents the right 

rear corner of your material: 

 
Fig. 39: Defining the right rear corner 

 The processing head moves to the right rear corner. 
7. Click on the button  in the dialog Material settings. 
 The material area is adapted. 
8. Click on the position of the screen that represents the front left corner of your 

material: 
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Fig. 40: Defining the front left corner 

 The processing head moves to the front left corner. 
9. Click on the button  in the dialog Material settings. 
 The material area is adapted to the material. 
10. Click on [OK]. 
 The phase Placement is started. 

 The material settings have been defined. 

 
 

The layout can be copied and placed freely on the base material for economic usage 
of the PCB material depending on the size of the layout and the size of the base 
material. 

 Placing the layout 

1. Enter the values for the desired position into the fields dX and dY. You can also 
move the toolpaths in the machining view using the mouse. 

 
Fig. 41: Placement 
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You can repeat the toolpaths in x and y direction by changing the values in the group 
Step and Repeat.  

2. Enter the value 2 in the field Y under Number of copies. 
3. Enter the value 0 mm in the field X under Spacing between copies. 
4. Enter the value 5 mm in the field Y under Spacing between copies. 

 

The field Spacing between copies automatically displays the value for the layout 
width. The desired spacing between the layouts has to be added. 

5. Click on [Apply]. 
 The layout is copied in y direction. 
6. Click on [Continue]. 
 The phase DrillFiducial is started. 

 The layout has been placed. 

 
 

Optical markings on the PCB surface – also called fiducials – are needed for aligning 
the top and bottom sides exactly to each other. They are drilled into the material in this 
phase. 

 

Using fiducials requires a camera system for optical fiducial recognition. This is 
included in the E44 as standard equipment. For further information contact the LPKF 
Service. 

 Drilling fiducials (E44 only) 

1. Insert the Spiral Drill 1.5 mm into the collet. 
2. Click on [OK]. 

If the spindle motor has not run yet, a 2-minute warm-up phase is started. 
 The phase Marking Drills is started. 

 The fiducials have been drilled. 

 
 

 Processing the material (Bottom side) 

1. Insert the Universal Cutter into the collet. 
2. Click on [OK]. 
 The phase Drilling Unplated is started. 
3. Insert the tool that is displayed. 
4. Click on [OK]. 

This phase may require several drilling tools corresponding to the drill diameters. 
 The phase Milling Bottom is started. 
5. Insert the tool that is displayed. 
6. Click on [OK]. 
 The phase Flip Material is started. 

 The material (Bottom side) has been processed. 

 
 



 

 

Operating the system 
 

ProtoMat E34/E44 

58/78  LPKF Laser & Electronics AG | V. 1.0 

 Turning the material over 

1. Remove the adhesive tape. 
2. Lift the material. 
3. Turn the material over along the y axis. 
4. Fasten the material with adhesive tape. 
5. Click on [OK]. 
 The machining view changes. The orientation of the layout is adapted to the 

orientation of the material. The side of the material to be processed is now the top 
side. 

 The material has been turned over. 

 
 

If no camera is available for processing the phase Read Fiducials_Top, the Top side is 
aligned to the Bottom side via the reference-hole system. The phase Read 
Fiducials_Top is not processed. 

E44 only 

If the fiducial search is started for the first time since the start of the program, the 
camera auto-focuses initially five times. The camera automatically moves to the 
positions of the fiducials and recognizes them. 

If the material is placed approximately at the same position as before, the fiducials 
should be found automatically and their positions should be stored. The Top side has 
thus been aligned to the Bottom side. 

The following dialog is displayed, if the fiducials are not found automatically: 

 
Fig. 42: Alignment 
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 Searching fiducials (E44 only) 

1. Enlarge the search area by increasing the value in the field Search area length. 
2. Start the search again by clicking on [OK]. 
3. Repeat steps one and two if necessary. 
 The phase Milling Top is started. 

 The fiducials are searched. 

 

Enlarging the search spiral also increases the time required for searching the 
fiducials. So ensure that the material is placed at the same position if possible when 
turning it over (if this is not predefined by using the reference-hole system). 
 
 

 Processing the material (Top side) 

1. Insert the tool that is displayed. 
2. Click on [OK]. 
 The phase Contour Routing is started. 
3. Insert the tool that is displayed. 
4. Click on [OK]. 
 A message informs you that the production of the printed circuit board is finished. 

 The material (Top side) has been processed. 

 

After the printed circuit board has been structured, solder resist and legend can be 
applied. LPKF offers the systems ProMask and ProLegend for these purposes. 
Furthermore, systems for applying solder paste, for assembly, and for soldering the 
printed circuit board are available. 
 
 

6.3.4 Switching off the system 
 

The system is switched off as follows: 
 

 Switching off the system 

1. Close CircuitPro PM. 
2. Use the On/Off switch to switch off the system. 
3. Press the Power button to switch off the extraction system. 

 The system has been switched off. 
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6.4 Special tasks 
 

This chapter describes rarely used tasks that may facilitate working with your system. 
The following steps are performed: 
 

 Adjusting the milling depth 

1. Affix the material to be processed onto the processing table as describe on page 
53. 

 
Fig. 43: Micrometer screw at the processing head 
 

 

2. Adjust the desired milling depth with the micrometer screw. 
3. Mill a test line. 
4. Check the result with a measuring microscope. 

 
Fig. 44: Optimum milling depth 

5. Repeat the procedure if necessary until sufficient material has been removed. 

 The milling depth has been adjusted. 
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 Drilling reference holes 

1. Remove any material and the drilling underlay plate from the processing table. 
2. Insert a screwdriver into one of the recesses next to the reference-hole strip. 

 
Fig. 45: Inserting a screwdriver 

3. Pry the reference-hole strip from the recess. 

 
Fig. 46: Removing the reference-hole strip 

4. Remove the other reference-hole strip (see steps 1 to 3). 
 The reference-hole strips have been removed. 

 

Fig. 47: Reference-hole strip 
1 Short end 
2 Mark 
3 Recess in the processing table 

 

 4 Mark 
5 Long end 

 

The reference-hole strip has a slightly curved shape with two marks. Depending on 
the distance from each end to the first mark, the strip has a short (1) and a long end 
(5). The short end (1) should be inserted into the recess (3) first. 

5. Insert a new reference-hole strip into the first recess (3). 

1 5 

2 
4 

3 
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Push the reference-hole strip within the recess towards the edge of the processing 
table as far as possible. 

 
Fig. 48: Inserting the reference-hole strip 

6. Insert the second reference-hole strip into the empty recess. 

 

The following instructions require that CircuitPro PM has been started and connected 
to the system. For more information on starting the system refer to page 44. 

7. Click on Machining > Drill reference holes. 
 The dialog Drill reference holes is displayed: 

 
Fig. 49: Dialog Drill reference holes 

8. Activate the function Drill both reference holes. 
9. Activate Use LPKF standard settings. 
10. Confirm by clicking on [Start]. 
11. If not already done, insert the reference hole drill (Ø 2.95 mm) into the collet. 

For more information on inserting a tool refer to page 65. 
12. Confirm by clicking on [OK]. 

 
Fig. 50: Reference-hole drill 

 The first reference hole is drilled. 
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13. Wait until the processing head moves to the front and the following message is 
displayed: 

 
Fig. 51: Prompt for cleaning the tool 

14. Clean the tool with a soft brush. 

 
Fig. 52: Cleaning the tool 

15. Confirm by clicking on [OK]. 
 The second reference hole is drilled. 
16. Clean the tool with a soft brush. 
17. Confirm by clicking on [OK]. 

 The reference holes have been drilled. 

 

 Inserting the dowel pins 

 
Fig. 53: Dowel pin and insertion tool 
1 Reference-hole strip 
2 Dowel pin 
3 Conical end 

 4 Reference hole 
5 Insertion tool 

 

1 

2 
5 

3 

4 
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1. Insert the first dowel pin into the insertion tool with the wide end first so that the 
conical end protrudes slightly from the insertion tool. 

 
Fig. 54: Inserting the dowel pin 

2. Place the insertion tool over the first reference hole. 
3. Hold the insertion tool fast with one hand. 
4. Press firmly on the insertion tool with the other hand to insert the dowel pin into 

the reference hole. 

 
Fig. 55: Inserting the dowel pin 

5. Insert the second dowel pin into the other reference hole. 

 
Fig. 56: Inserted dowel pin 

 The dowel pins have been inserted. 

 

If the dowel pins protrude too far from the material, you have to adjust the milling 
depth and drill the reference holes again. 
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 Inserting a tool into the collet 

Systems without tool magazine require that the tools are inserted manually according 
to the project requirements. The processing head has to be moved to the Zero 
position for a tool change. 

1. Click on Tool magazine. 

 
Fig. 57: Icon tool magazine 

 The following dialog is displayed: 

 
Fig. 58: Manual tool exchange  

2. In the drop-down list select the tool that you want to use. 
3. Click on [Continue]. 
 The following dialog is displayed: 

 
Fig. 59: Tool Exchange 

4. Insert the tool that you want to use into the provided insertion tool (2). 
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Fig. 60: Inserting a tool 
1 Collet 
2 Insertion tool 

 3 Locking screw 
4 Screwdriver 

 

 

5. Use the provided screwdriver to loosen the locking screw (3). 
6. Insert the insertion tool (2) with the inserted tool into the collet (1). 
7. Tighten the locking screw. 
8. Click on [OK]. 

 The tool has been inserted into the collet. 

 

1 

4 

3 

2 
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7 Maintenance 
 

This chapter contains important information about maintenance of the system. 

Proper maintenance and the proper operation of the corresponding supply units – in 
this case the extraction system – are basic requirements for a smooth function of the 
system. 

Maintenance has to be performed and documented regularly according to the 
manufacturer's instructions. 
 

The system is designed for a service life of 10 years used in one-shift operation (10 
hours a day). The specified maintenance intervals are valid for one-shift operation at 5 
days a week. 
 

7.1 Safety 
 

Follow the safety instructions below for your own protection and for the protection of 
other persons in the vicinity of the maintenance work. The maintenance personnel 
must ensure that the described prerequisites for the planned maintenance tasks are 
fulfilled and they must observe the special warning messages for the individual 
maintenance tasks. 
 

 DANGER 
Danger to life by electrical shock! 
Touching energized parts causes a direct danger to life by electrical shock. Damage 
to the insulation or damaged individual parts can be dangerous to life. 
 All work on energized components of the system must be performed by a 

qualified electrician. 
 If the insulation is damaged, switch off the power supply immediately and initiate 

the repair. 
 De-energize all energized components of the system or equipment, before 

working with them. Ensure that the system or equipment is de-energized for the 
whole time of the task. 

 Never bridge or deactivate fuses. 
 Always keep moisture away from energized parts because it can cause a short 

circuit. 

 
 
 

7.2 Maintenance schedule 
 

The following tables provide an overview of the maintenance tasks that have to be 
performed by properly trained personnel. 
 

Component/Assembly Interval Task to be performed Remark 

Circuit board plotter Before each startup Visual check See page 68 

Circuit board plotter Regularly Cleaning See page 68 

Collet After 100 operating 
hours 

Cleaning See page 68 

Extraction system When the extraction 
power weakens 
noticeably. 

Replacing the HEPA filter See user manual of 
the extraction system 

Table 6: Maintenance schedule for the maintenance personnel of the operator 
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7.3 Maintenance tasks for the maintenance personnel of the 
operator 

 

This chapter contains a detailed description of the individual maintenance tasks that 
may only be performed by the maintenance personnel of the operator. For information 
on maintenance tasks of the extraction system refer to the manufacturer's user 
manual. 
 

 Performing a visual check 

1. Check the mains cable (of the circuit board plotter), the USB cable (to the PC), the 
D-Sub cable of the extraction system, and the extraction hose for visible damage. 

2. Replace damaged cables and hoses immediately. 
3. Check the processing head and the processing table for visible damage. If you 

find damage: 
 Ensure that the system cannot be used. 
 Contact the LPKF Service. 

 The visual check is concluded. 

 

 Cleaning the system 

1. Disconnect the mains plug from the wall socket. 
2. Remove material residues from the processing table using a soft brush and a dry 

antistatic cloth. 
3. Connect the mains plug to the wall socket. 

 The system has been cleaned. 

 

In case of stubborn dirt and stains, a slightly damp cloth can be used. 

 
 

 Cleaning the collet 

1. Move the processing head to the zero position. 
2. Apply the insertion tool to the tool. 

 
Fig. 61: Insertion tool 
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3. Use the provided screwdriver to loosen the locking screw. 

 
Fig. 62: Loosening the locking screw 

4. Remove the tool from the collet. 

 
Fig. 63: Removing the tool 

5. Use the collet brush to clean the insides of the collet. 

 
Fig. 64: Cleaning the collet 

6. Use the insertion tool to insert the tool into the collet. 
7. Tighten the locking screw. 

 The collet has been cleaned 
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8 Troubleshooting 
 

This chapter contains an overview of possible faults and measures for 
troubleshooting. 

If faults occur that cannot be eliminated by the following messages contact the 
LPKF Service. 
 

8.1 Fault display 
 

The system's operation LED indicates occurring faults. In the software, faults are 
indicated via the panes Fault monitor and Messages. 

Fault monitor pane 
The Fault monitor pane contains a list of all system messages. These can refer, for 
example, to a problem at the start of the system or to error messages during 
production of the part. 

 Click on View > Fault monitor to open the Fault monitor pane: 

 
Fig. 65: Fault monitor pane 
 
 

Column Description 

Client ID ID of the system component that reported the error. 

Client Description Description of the system component that reported the error. 

Unit ID ID of the component in the system where the error occurred. 

Unit Description Part of the component where the error occurred. 

Fault ID Error ID 

Fault Time Displays the time and date when the error occurred. 

Fault Code Error code 

Fault Description Detailed description of the error that occurred. 

Accept time Time when the error was acknowledged. 

Table 7: Fault monitor 
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Icon Name Description 

 
First Jumps to the beginning of the list. 

 
Previous Jumps up one row in the list. 

 
Next Jumps down one row in the list. 

 
Last Jumps to the end of the list. 

 
Accept Acknowledges the selected error in the list. 

 
Accept All All errors not yet acknowledged are acknowledged 

automatically. 

 
Clear The selected error that has already been acknowledged is 

deleted from the list. 

 
Clear All All errors already acknowledged are deleted from the list. 

Table 8: Fault monitor icons 
 

Pane Messages 
The pane Messages displays the following information: 

 
Fig. 66: Pane Messages 

 

Type Description 

Error Errors are critical program errors.  
The Errors can be displayed or hidden by 
clicking on [Errors]. 

Warnings Warnings are due to input errors that the user 
has caused. For example, these can be 
information on aborted or improperly executed 
actions.  
The warnings can be displayed or hidden by 
clicking on [Warnings]. 
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Type Description 

Messages Messages present statistical information of the 
program. These can be feedback of CircuitPro 
PM on certain actions that have been 
executed, e.g.: “New document ... created”.  
The messages can be displayed or hidden by 
clicking on [Messages]. 

Service messages Service messages are displayed when 
maintenance of the system is due. Contact the 
LPKF Service. 
The service messages can be displayed or 
hidden by clicking on [Service]. 

Raise selection Highlights the selected action in the CAM 
view.  
Example: You draw a rectangle. The 
Message pane displays a corresponding 
message (e.g. Rectangle Drawn_5 has been 
created). If you activate [Raise selection] and 
click on the message, the rectangle is 
highlighted in the CAM view. 

Table 9: Pane Messages 
 

8.2 Actions in case of an error 
 

 Clearing faults 

1. Read the error description in the fault monitor. 
2. Remedy the fault. 
3. For a new initialization, acknowledge the fault if necessary. 

 The fault has been cleared. 

 

If the faults still exist after initialization, restart the system software. If you have any 
questions contact the LPKF Service. 

 
 

8.3 Fault table 
 

The following table contains possible faults and proposals how to clear them. 
 

Description Component Possible cause Remedial measures 

No connection 
between system 
and PC 

System Missing power 
supply 

Check the mains cable and plug the 
mains plug back into the wall socket. 
Click on Machining > Connect. 

System switched 
off 

Switch the main switch at the system 
to the ON position. 
Click on Machining > Connect. 

No data transfer 
via the USB cable 

Check the USB cable connection 
between the system and the PC for 
damage or loose connectors. 
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Description Component Possible cause Remedial measures 

Replace the USB cable if damaged. 
Click on Machining > Connect. 
Follow the instructions on page 45. 

Check the USB settings of the 
operating system. 
Click on Machining > Connect. 
Follow the instructions on page 45. 

No extraction Extraction 
system 

Missing power 
supply 

Check the mains cable and plug the 
mains plug back into the wall socket. 

Extraction system 
switched off 

Set the mode selector switch to the 
position ON or AUTOMATIC. 

Circuit breaker 
triggered 

Reset the extraction system. 

No data transfer Check the cable connection between 
the circuit board plotter and the 
extraction system for damage or 
loose connectors. Replace the cable 
if damaged. 

Tool jammed Collet Tool has not been 
inserted correctly 
into the collet 

Insert the tool into the collet up to the 
stop with the tip facing down. 

Collet clogged 
with dirt 

Clean the collet. 
Follow the instructions on page 68. 

Table 10: Fault table 
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9 Disassembly and disposal 
 

This chapter describes the disassembly and the disposal of the system. 
 

The following tasks may only be performed by the maintenance personnel of the 
operator. 
 

9.1 Safety 
 

NOTICE 
Environmental hazard by improper disposal of the system! 
Improper disposal of the system can cause hazards to the environment. 
 Dispose of the system properly or contact the LPKF Service. 

 
 
 

9.2 Preparations 
 

Before disassembling the system: 

 Switch off the system. 
 Disconnect all external components and de-energize the residual energy. 
 Remove all operating materials, auxiliary materials, and consumables and dispose 

them of in an ecological way. 
 

9.3 Uninstalling the system 
 

The system is disassembled as follows: 
 

 Uninstalling the system 

1. Disconnect the mains plug from the wall socket. 
2. Disconnect the hose of the extraction system. 
3. Disconnect the control cable of the extraction system. 
4. Disconnect the USB cable connecting with the PC. 
5. Disconnect power supply cable. 
6. Install the foam pad as a transport lock beneath the processing head. 

 The system has been uninstalled. 

 

The PC and the extraction system can now be used for other purposes or can be 
stored as well. For information on uninstalling these systems refer to the 
corresponding user manuals. 
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9.4 Disposing of the system 
 

LPKF AG will accept a delivered product for which a manufacturer's obligation to take 
back is based on the Waste Electrical and Electronic Equipment directive and will 
dispose of it according to regulations. Contact the LPKF Service for more information 
on returning the system. The contact data are listed in the information on customer 
service. 

The LPKF Service provides a return goods authorization number if you want to return 
the system. 
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10.3 EC Declaration of conformity 
 

 
Fig. 67: Declaration of conformity 
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